LJRoland

A

Adobe PostScript 3

XC-540MT

SPECIAL COLOR INK GUIDE
(Metallic Silver & White)

When using metallic silver ink and white
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This document describes the characteristics of special color inks (white ink and metallic silver ink) used with
XC-540MT, important notes, maintenance, and printing method using these inks. For other matters, refer to the
XC-540/XC-540MT Setup Guide and the XC-540/XC-540MT User's Manual.
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Thank you very much for purchasing this product.

» To ensure correct and safe usage with a full understanding of this product's performance, please be sure to
read through this manual completely and store it in a safe location.

» Unauthorized copying or transferal, in whole or in part, of this manual is prohibited.

» The contents of this operation manual and the specifications of this product are subject to change without
notice.

» The operation manual and the product have been prepared and tested as much as possible. If you find any
misprint or error, please inform us.

» Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur through
use of this product, regardless of any failure to perform on the part of this product.

» Roland DG Corp. assumes no responsibility for any direct or indirect loss or damage which may occur with
respect to any article made using this product.
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1-1 What This Document Assumes and Related Manuals

What This Document Assumes

Before performing any operations described in this guide, make sure that all the following preparations are
complete.

» Assembling and installing the XC-540MT unit

» Installing VersaWorks on your computer, and connecting the computer to the XC-540MT via a network

Related Manuals
Read the following documentation for information about setting up the XC-540MT unit and VersaWorks.

(1) Setup Guide
This manual covers details about how to use the XC-540MT, including how to set up the printer and where to
locate the printer, etc. Be sure to read this manual.

(2) User's Manual
This manual describes operation methods in detail. After you've read the XC-540MT Setup Guide, be sure to
read this manual.

(3) VersaWorks Quick Start Guide

This manual explains basic operations of VersaWorks, including how to set up the program. Be sure to read
Chapter 1 of this manual and make necessary setups on your computer. It is also recommended to read Chapter
2 of this manual and become familiar with how to use this program.

VersaWorks Online

This document describes the important notes for using the metallic silver ink and white ink as well as the basic
printing method. You can get the latest information about Roland VersaWorks and the information on printing
methods requiring more complex settings by viewing VersaWorks Online.

If you want to learn more about the features of Roland VersaWorks, or if you want to use metallic silver ink and
white ink more effectively, be sure to visit VersaWorks Online.

URL: http://dg4.roland.co.jp/en/RVW2forWeb/index.html

4 Chapter 1 Getting Started
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1-2 Before Starting Operations

Important: Characteristics of Inks and Important Notes

The usage and handling of white ink and metallic silver ink involve some important considerations that do
not apply to ink of other colors.
Be sure to familiarize yourself with the characteristics of inks before you use it.

White ink and Metallic Silver ink settle and separate.

> If it is allowed to stand, the precipitated material may solidify and cause clogging of the print heads or
other malfunction. Be sure to observe the cautions in this manual.

Maintenance must be performed.

» Always keep the main power switched on. If the main power is switched off, the automatic maintenance
function stops working, and may result in malfunction.

» We recommend operating the printer at least once a week.

> If the printer is left unused for a long period of time, ink precipitation may occur, resulting in an incorrect
ink discharge such as occurrence of dot drop-out. In such cases, the precipitated and solidified ink needs
to be discharged. This work requires two SOL INK cleaning cartridges. For how to perform the work, refer
to the description below.
= P. 64, "When Dot Drop-out etc. Cannot be Corrected"

Drying inks

» After output, allow the ink to dry sufficiently. Note that white ink and metallic silver ink in particular require
printing at a high density, and so are more difficult to dry than CMYK inks.
» Use an auxiliary drying unit (DU-540).

We strongly recommend performing lamination.

» Depending on conditions, the weatherability of metallic silver ink and white ink may be inferior to that of
CMYK inks. Therefore, laminating is strongly recommended.
» Maintenance requires two SOL INK cleaning cartridges, so be sure to have these on hand.

Before Starting the Day's Work

» Remove just the white and metallic silver ink cartridges, shake them gently, then reinsert
them.

» The cyan, magenta, yellow, and black ink cartridges do not need to be shaken every day, but
new cartridges for these colors should be shaken when you install them.

The ingredients in white and metallic silver ink tend to settle. Each day, before starting the day's operations,
be sure to carry out the above steps. Allowing the ink to stand without carrying out these steps can cause the
settled material to harden, resulting in malfunction or other problems.

Chapter 1 Getting Started 5
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1-3 Important Notes on Printing

When Performing Pullback Printing

What is Pullback Printing?

Pullback printing refers to a printing method in which the white-ink (or metallic silver ink) undercoat is printed
first, and then CMYK color is printed on top of white ink (or vice versa); in the process, the already printed
media is pulled back to the original position once, and then overprinting is performed.

Allow the ink to dry thoroughly.

» Dry the ink sufficiently before you perform pullback printing with the next color. Performing pullback
printing before the ink has dried enough may make attractive printing impossible or cause problems such
as reduced weatherability.

» Drying time differs according to various conditions, but as a general guide you should use an auxiliary
drying unit (DU-540) and also allow the media to stand for an additional 15 minutes.

» In particular, when you're pullback printing a white or metallic silver undercoat with CMYK inks, allow the
undercoat to dry thoroughly before you overprint it. If the undercoat is not dry enough, differences in
dryness may cause variations in the overprinted CMYK colors.

Using the middle pinch rollers

» The middle pinch rollers may smudge the printed surface when the media is pulled back. When you per-
form pullback printing, we recommend securing the media in place using only two pinch rollers (one on
the left and one on the right).

Never use the media take-up system

» Performing pullback printing requires pulling the media back, and so the take-up unit cannot be used.

When Using Transparent Media

Loading transparent media

» Set the [EDGE DETECTION] menu item to "DISABLE". Transparent media cannot be loaded unless this set-
ting is made.

» Ensure a margin of at least 75 mm from the leading edge of the media to the printing- or cutting-start
location.

Important notes on the amount of media remaining

» When you use transparent media, the presence of media cannot be detected. In such cases, printing opera-
tion does not stop when the media runs out, and there is a chance that the platen or the like may become
soiled by ink or that ink may get inside and damage the machine.

» If media runs out while printing is in progress, immediately press to quit printing.

6 Chapter 1 Getting Started
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1-3 Important Notes on Printing

Using the middle pinch rollers

» The middle pinch rollers damage media slightly, and on transparent media this damage can be very notice-
able. If such damage is a concern, we recommend securing the media in place using only two pinch rollers
(one on the left and one on the right).

Automatic crop-mark detection

» Automatic crop-mark detection may not be possible for some media, such as transparent media. In such
cases, perform alignment manually.

Chapter 1 Getting Started 7
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2-1 Preparing VersaWorks

Starting VersaWorks

On the computer you're using, start VersaWorks. For information on how to start the program, see the Roland
VersaWorks Quick Start Guide. After starting the program, go to the upper left of the main screen and check to
make sure that "Model (or Nickname) of Your Printer" is displayed, and that "Status" is set to "Ready to Print."

File(F) Edit(E) View(V) Job()) Printer(P) Media(M) Help(H)

Creating a Folder for Saving PS Files

Before you actually print an image you draw using application software such as Adobe lllustrator, it is necessary
to save the image as a PS file (s). And then, you can print the image by loading the PS file (s) on VersaWorks.
Because of this, you should create a folder for saving PS files in advance. Itis recommended to locate the folder
in the root directory on your computer's local disk.

Procedure

o Open [Computer] (or [My Computer]), and then open [Local Disk (C:)].

On the [Organize] menu, click [New
Folder]. (Or on the [File] menu, click
[New], and then click [Folder].)

| Favorite Links Size

| Program Files
File Folder

J‘ Documents

| B Music

Enter the name for the folder, and then
press the Enter key.
Here you name "MT-WH_print', for example.

ws ~ [B Open [ Share @ Bum

Favorite Links Size

[h:n:::nants ) MT-WH_print | UM} ;rlngrDaIrg;IE;
10 Chapter 2 Getting Ready
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2-2 Printer Preparations

Making the Printer Settings and Loading Media

When Using Transparent Media

When you're using transparent media, make the necessary printing settings on the printer and load the media
accordingly.

Procedure

€@ Press CvenuD and make the following settings.
[EDGE DETECTION] to "DISABLE."

9 Load transparent media into the printer.
» When the media warps or partially floats, ensure a margin of about 200 mm from the leading edge of
the media to the printing- or cutting-start location.
» Be sure to use the media clamps when you load media.

When Using Media Other Than Transparent Media

Load the media using the method described in the XC-540/XC-540MT User's Manual.

Chapter 2 Getting Ready 11
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2-3 Creating Printing Data

Basic Approach for Creating Printing Data

When Using Metallic Silver Ink

When you print using metallic silver ink, you can create the printing data according to the two methods
below.
» Specify the spot color so as to use only the metallic silver ink.
Apply the spot color named "RDG_MetallicSilver" to the areas you want to print using the metallic silver
ink.
» Use the exclusive metallic color special colors library.
From the exclusive metallic color special colors library, select the metallic color to be used which is the
combination color of CMYK ink and metallic silver ink.

When Using White Ink

Apply the spot color named "RDG_WHITE" to the areas you want to print using the white ink.

Creating Data for Printing

Create the data for printing using the metallic silver ink and white ink.

The program used to create the printing data is Adobe Illustrator CS3. For detailed information on drawing
methods and how to work with palettes, refer to the documentation or online help for Adobe Illustrator
CS3. If you're using another version of Adobe lllustrator, operations may be somewhat different from those
explained here.

1. Open the exclusive swatch library.

o At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
The "Select Library" window appears.
NOTE:  The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].

Art History 3
Celebration
[swatere ~ I : Color Baaks '
e Color Properties 3
Corparate
Default Swatches 3
] % B T BN @ ' Earthtone
Foods 3
Gradients 3
Al Kids Stuff
Add Used Calors Metal
Sort by Mame Mature 4
Sont by Eind Meutral
Show Find Field Patterns 4
Scientific 3
v Small Thumbnail View i
Medium Thumbnail View (el
Large Thumbnail View System (Windows)
Small List View T
Large List View VisiBone2
Swatch Options Web
Spet Caloen Usar Pistic ot ,
(=
% \GE ., iy Vo
Save Swatch Library as AL. |

12 Chapter 2 Getting Ready
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2-3 Creating Printing Data

9 (DOpen folder in the order of [Computer] (or [My Computer]) — [Local Disk (C:)] —
[Program Files] — [Roland VersaWorks] — [Swatch] — [lllustrator], then select "Roland

VersaWorks.ai."
Depending on the settings of your computer, the extension "ai" might not be shown.
@Click [Open].
The swatch library containing "RDG_MetallicSilver" and "RDG_WHITE" is displayed.
\ul Select a library to open: ==
Lookin | lustiator ) - @® e E
D Name = Date modified Type Size
=5\ T Roland Calor System Library 2006/12/11 14:49 Adobe Tllustrator Art. 175
Recent FlacE: g 009/08/18 19:44 Adabell Art.. 26
. I KﬁRn\deevsiWarks I‘ﬂﬂ!/ﬂi/ld 17:40 At 46
Desktop
0
XXXX
LY
Computer > P,
L || Roland VersaWorks x ey
ot g i : [ e m -
File name: Roland Versaworks - ]
Festts  [SomchFEet) ) —| ‘ 2 roG_wHITE ]
®) —_— om
B ROG_MetalicSibver =
x
&m < > =

9 1Open the same folders as in step 9, then select "Roland Metallic Color.ai."”
Depending on the settings of your computer, the extension "ai" might not be shown

@Click [Open].
The swatch library is displayed which is containing the "metallic color" created by mixing the metallic
silver ink and CMYK ink.

L) Select alibrary to open: =

Ly || ustiator - @2 pE
T 'Name = Date modified Type Size
& = = = 006/12/11 149 Adobe lustrator Art... 115
Recent Places By Roland Metallic Color 009/08/18 19:44 Adobe Hlustrator Ar... 246

-1 009/05/14 17:40 Adobe Dlustrator Art... 46
Desktop
b
XXXX
LY
Computer iz
L _] Roland Metallic Color x 7=
Network ¢ [ i < "
o w o~
File name: Roland Versaworks ( | ’ D RYW-MT-Silver @
Files of type: Swatch Fies ) @ m— | ‘ . RywwW-MT-Bronze m l—l
W Rovy-MT-TitarBlack Fd
[ Rvwy-paT-Maraon =
M puip T oiclst EE T
@ « L3 i

By saving the "ai" file selected in steps O and O into the folder below, you can register each swatch
library to the Adobe lllustrator's library.

C:\Program Files\Adobe\Adobe Illustrator CS3\Preset\Swatch

("C"is the name of your computer's local disk.)

Once the registration is performed, you can open the library directly from the swatch palette menu, elimi-
nating the need to search the file every time you start Adobe Illustrator.

Chapter 2 Getting Ready 13
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2-3 Creating Printing Data

2. Create the illustration, and specify the spot color that matches the color you want to print.

o Create the illustration.
Be sure to draw the illustration in the CMYK mode.

9 Specify each spot color that matches the color you want to print.

Desired ink or color Spot color name
Metallic silver ink RDG_MetallicSilver
White ink RDG_WHITE
Metallic color RVW-MT-Silver, RVW-MT-Bronze, RVW-MT-
(Metallic silver/CMYK combination color) TitanBlack, etc.

. Adlobe Tllustrator - [sampled Lps @ 2§4,86% (CMYK/Preview) ]
ﬁ File Edit Object Type Select Filter Effect View Window Help

| Mo Selection Strake: Erush:|:E| Style: Opacity: | 100 bl nﬂH

Specify "RDG_WHITE" for
the areas where you want to
use white ink.

Specify " RDG_MetallicSilver " for the
areas where you want to use metallic
silver ink.

— = -
P\ weight: [+ 1 pt

Apj Glj RolandVersaWorksxh -/v:
[ BEE -
B roa wiHiTe BE @
O roc_cross BEE
I oG Metalicsiver

3 E:

@ «

o]
@
4

[ Roland Metallic Color x 5 b ls _/_%
[ ryws-paT-sitver BEE -
[ rovr-tT-Bronzs BEE ]
I Ror-waT-TikanElack BEE
. RYY-MT-Maroon =] -
B

& « »

——— — X
| Layers x =

e | e —

Areas where you want to use metallic color
= From the metallic color special colors library (Roland Metallic
Color), specify the color such as "RVW-MT-Bronze"

284859 - | (@ Open (K] ™= 3

T tLayer H 4 B W g ‘

Using the metallic silver ink, you can perform the blend print and the layered print by combining the

ink with the CMYK ink.
= P. 18,"Blend Print and Layered Print (Metallic Silver and CMYK)”

14 Chapter 2 Getting Ready
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3. Create the PS (PostScript) file.

o

ment Color Mode ’

2-3 Creating Printing Data

(DSelect [Print] from the [File] menu.

Fi(File) Edit Object Typ;: Select Filter Effect View Windo
New.. Cul+N =
g::nmmme smﬂ;z:::g @Select [Roland VW]
When a nickname is set, or when more than one
y == printer is connected, select “Roland VW_{(the
Close Ctrl+W.
PR nickname of the printer used for output).”
- Save Asu. Shift+Ctrl+S.
'ﬁ G Alts il S
*E Save as Template. ;
¥ = ®Click [Setup].
q Revert F12
= Place..
R @Click [Continue].
Export.
EOmmm e AeCtiep

Tavr At Shife-Ctrls]

Ctrl+P.

Cti+Q

e <3

@t Preset_Custam -

Printer:  Rolandv -

T roIand VersaWorks) -

Gereral

Copies: 1| | [Jcoiate [CReverse Order

Pages: @ All
L
[I5kip Blark Pages
[~ Media
Size:  Defined by Driver -

Orientation: [ Transverse

[~ Ontions
Print Layers:  Visble & Printable Layers -

® Do Not Scale
OFitto Page

© Cstomscak: Widh i e

¥ The Print Setup dialeg box is provided by the operating
4 system.To ensure that you can use the full print capabilities of
Tllustrator, please set all print options from the Print dialog box.

Dor sw Again

Return to Print Dialeg ]

CC comtne ]
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2-3 Creating Printing Data

(2]

16

= Print E
General

Select Printer

Name Documents | Status Comments » ‘

S @ @
‘ | — T
Status  Ready 1] Brint to
Losation,
Comment Pl

Page Range

@ Al Humber ofcopies: 1 4
Selection Current Fage
(1) 22 33

= Printing Preferences =
Layout | Paper/Guslity

Orientation:

.
Page Order:

Front to Back -

Fage Format

Paces per Sheet I

[]Draw Borders

o[T

C >
Cancel_]

e ——————
Roland VersaWorks Adval =) Ansi C

B

—————————— [ AnsiD
0 Roland VersaWorks 3 g -

4] Paper/Qutput | 3 ARCH A
P 5] aRcHe Page
=-[u] Graphic [E) ARcHC
| D) image Colol [E] ARCHD
1CM Mef E] ARCHE

e 1CM Tnte ] B
Scaling: 100,
- TrueTypeFe =5 o

& f Document Opti 5 Legal
Lo Advanced 7 \tter
G Pages per sersizeAl
-8 PostScript (o

PostScript Custom Page Size

=i

PostScript Custom Page Size Definition ==
Gustom Page Size Dimension @ Unit
width: &0 (25 JONZA47 00) B Inch
ey @) Millime
Height: 40 25f0.11557 003 @ P' '"le ik
&) Poin
Paper Fead Direction: [Short Ees First 9

Paper Type Cut Sheat

Offsets Relstive to Paper Feed Direction

|§\ Roll Fead

Perpendiculsr Direction: an0 {00, 0400
Faralle] Dire ction: opo 000,000
[ ok ] [ cancel | [Restore Defults |
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DTurn on the [Print to file] option.
@Click [Preferences].

(®Click [Advanced] in the [Layout] tab.
For Windows 2000: In the "Print"
dialog box (the window at the very top
of this page), go to the "Layout" tab and
click [Advanced].

@Click the down arrow to the right of
the [Paper Size] box, and then click
[PostScript Custom Page Size] from the
list that appears.

®For "Custom Page Size Definition,"
enter the values in the "Width" and
"Height" fields.

Enter values for the same size as the illustration
you created in step 2.
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2-3 Creating Printing Data

@ Click [OK] three times to close the "PostScript Custom Page Size Definition," "Roland
VersaWorks Advanced Options," and "Printing Preferences" dialog boxes.
The "Print" dialog box returns.

(4]

o= Print

e

Seleot Frinter
Name Doc
[ RolandV.

Seleotion

uments Status Comments
==
191 Frint o e
FindFrier

Mumber ofcopies: 1 2]

C [>T

Print Pre

N i

S

P

(R.D.GJE

eset:  Custom -
inter:  Rolandvw -
PPD:  Dsfault (Roland Versaiiorks) -

General

Copies: 1 [caiate [ Reverse Order

Pages: @ All
s )

[skip Blank Pages

-~ Media
Sie:  Defined by Driver -

Height
] [ Transverse

width

Orientation:

[~ Options
PrintLayers:  Visible & Printable Layers -

® Do Mot Seale

©FittaPage

‘I]CustumS(a\E@ §  Heiont
\&/

) Ccgdo ) Cpoe )

(1)

AL
@& e
g
Recent Places

- 08 @
Date medified Type Size

This folder is empty.

Select the folder you created in "Creating
a Folder for Saving PS Files" on page 1

e

BRER
LY
Computer
[

L

Network

Fie name

Stz tw’ - . ]

A\

D

@click [Print].

@click [Print].

@Specify the destination and file name
for saving, then save the file.

Example: " C:\MT-WH_print " for the folder to
save to, and " mt-wh.ps " as the file name

@click [Save].
The CMYK layer of the image is saved as a PS
file.

and metallic silver ink.

Assign the name you want. It may be a good idea to
assign a name that indicates that the file uses white

@ Open the folder you saved to and make sure the file has been created.
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2-3 Creating Printing Data

Blend Print and Layered Print (Metallic Silver and CMYK)

Using the metallic silver ink, you can perform the blend print and the layered print by combining the ink with
the CMYK ink. By this means, you can realize the metallic expressions that cannot be made only with the CMYK
ink. The printing methods are different between the blend print and the layered print, and so are the metallic
impressions of the CMYK colors. Select and use the types of printing to suit your taste.
= P. 24, “Blend Print (Metallic Silver + CMYK),” p. 26, “Layered Print (Metallic Silver = CMYK),” p. 28, "Layered Print
(CMYK = Metallic Silver )"
* When you perform “Printing with White, Metallic Silver, and CMYK Ink” (page 32), the printing method is
limited to the blend print.

In performing the blend print or the layered print, you can specify the colors from the metallic color
special colors library. However, if you specify the metallic colors with the same names for the blend
print and the layered print, the tones of the colors are different between them. We recommend that
you check the tones of the colors by performing the test printing or printing out the Metallic Color
Chart.

Seeing the metallic color chart for the layered print, you may feel a slight inconsistency between the
names and the tones of the colors. This is because the colors listed in the Metallic Color Chart are
named based on those for the blend print.

= P. 38, “Printing the Metallic Color Chart”

Blend Print

(Image of printing method)

to be a single layer for printing.

[

The metallic silver ink and the CMYK ink are blended ]

~f ‘ Media
8 N N

N
[?&?&Iic Silver and

18 Chapter 2 Getting Ready
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2-3 Creating Printing Data

Layered Print

(Image of printing method)

The metallic silver ink and the CMYK ink are separated into the different layers
and printed in that order. (Metallic silver ink = CMYK ink)

T

Media

’ ‘ { Metallic Silver

The printed image is to be
seen from this side (the printed
surface of the flnlshed results).

CMYK

The metallic silver ink and the CMYK ink are separated into the different layers
and printed in that order. (CMYK ink = Metallic silver ink)

————— Media
The printed image is to be seen from
this side (the opposite side of the printed
surface of the finished results).
Chapter 2 Getting Ready 19
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3-1 Print Job Setting

Printing Only with Metallic Silver Ink

This section describes how to perform printing only with the metallic silver ink. To use the metallic silver ink
in printing, you need to use the printing data where the use of the metallic silver ink is designated. If the
printing data have the portion designating the use of other colors, with the settings described in this section,
you can print with the metallic silver ink only the area of the image which has been designated to print with
the metallic silver ink.

= P. 12, “2-3 Creating Printing Data”

Procedure

ake sure that you have finished making the preparations for VersaWorks, getting the
@ mak that h finished making th ti for Vv Work ing th
printer ready, and creating the printing data (= page 9, "Chapter 2 -- Getting Ready").

Double-click @

Queue A Properties" window appears.

(2]

Tre—
Roland VersaWorks
File(F) Edit(E) View(V) Job({)) Printer(P) Media(M) Help(H)

1 XC-540MT

Statuo Ready to Print

o |

tedia Type :
IGaneric Wingl | ;I
Frint Quality " High Quality
£ Standard
" High Speed
I
- pmcon For [Media Type], select names with [MT]
(e attached such as "Generic Vinyl 1 [MT]".
|§e”5'_‘°\‘j_‘”yl'1‘ M7 =] Make the selection that matches the media to be
e ENENC Y
i - used. Selecting an item attached with [MT] enables
enenc Yinyl 2
\ [ you to choose the print mode that can use the me-
|Ganeric Banner2” tallic silver ink.

15 i Wirwl | M1 ~| . . . .
| N T | For [Print Quality], select [High Quality]
Glualiy " High Quality [Lapered)
AdiEgtlﬁ:enl Daonbiown - 1770 w1440 dri ~|
i. Mode [ChvKME (v) +PASS =l Lo
' Detads For [Mode], select [MetallicSilver (v)].
File: Format s MK [v] +PASS
- JomeT T

I

22
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3-1 Print Job Setting

o = \‘ Click Tl |
] |‘ Dretailz |
— | Tur on the [Convert Spot Color] option.
- Spot Colors
Guality
o 1
e | | Click B

Cut
Cantrols

7 In [Operation Mode], select the operation of
@ Cutting Opticn: .
Operation Mode : IPnn[ & Cut the prl nter.
it Pnnt & Cut
R [ Cut &l Paths
[~ Cut lmage Bour CutDnIy
Tualibn | ‘ ™ Return to Oriin After Print

‘ Click [OK] to close the "Queue A Properties™

Vanable window_

Data

E

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings,
refer to the online help provided for VersaWorks.

* If you select [CMYK (v)] for [Mode] in the procedure @ only the area of the image where CMYK is specified
in the printing data is to be printed.

Chapter 3 Printing 23

Downloaded from www.Manualslib.com manuals search engine


http://www.manualslib.com/

3-1 Print Job Setting

Blend Print (Metallic Silver + CMYK)

This section describes how to perform the blend print with the metallic silver ink and CMYK ink.
= P. 18, “Blend Print and Layered Print (Metallic Silver and CMYK)”

To perform the blend print, you need to use the printing data where the use of the metallic silver ink and the
CMYK ink is designated.

= P. 12, “2-3 Creating Printing Data”

Procedure

o Make sure that you have finished making the preparations for VersaWorks, getting the
printer ready, and creating the printing data (= page 9, "Chapter 2 -- Getting Ready").

Double-click @
Queue A Properties" window appears.

(2]

—
Roland VersaWorks
File(F) Edit(E) View(V) Job({)) Printer(P) Media(M) Help(H)

| XC-540MT

Statuo Ready to Print

[ Yl A\

Media Type :
IGenenc Wil | LI
Print Quality: € High Qualiy
& Standard
- " High Speed

it I
@] - ot For [Media Type], select names with [MT]
L (Hedia Tope attached such as "Generic Vinyl 1 [MT]".

|GE”E"“\‘:‘W” M1 & Make the selection that matches the media to be

used. Selecting an item attached with [MT] enables
you to choose the print mode that can use the me-
tallic silver ink.

eneric Yinul 1 [MT
Generic Vinyl 2
Generic Winyl 2 [MT]
Generic Banner 1

| Generic Banner 2

| Generic Yinyl | [MT] =l B . . .
e For [Print Quality], select [High Quality].
Guality © High Duality [Lapered)
e Resoluion:  [720% 1440 dpi -1
i. { Mode okt (v] +PaSS -]
sl ' CHPKRL [v] +PAES
i s MieslicSiver (] +PASS For [Mode], select [CMYKMt (v)].
Ifplremie P CMYE [v] +PA55
Ta |k Ltk —

24 Chapter 3 Printing
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e | =
Printer

Cut
Cantrals

| =

—

AL

Dretailz |

| Bt S il = (R

~Spot Colors

IV Corvert Spat Colo

IPrlnl & Cut

3-1 Print Job Setting

Click "2 .

Turn on the [Convert Spot Color] option.

Click B .

In [Operation Mode], select the operation
of the printer.

Layout

,_Euttmg Option:
Operation kode
Frint & Cut
™ Cut Al Paths m_ d
I~ CutImags Boundzdt Ol

| | ™ Retumn to Origin After Print

E

Waniable
Data

Click [OK] to close the "Queue A Proper-
ties" window.

o

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings,
refer to the online help provided for VersaWorks.
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3-1 Print Job Setting

Layered Print (Metallic Silver = CMYK)

This section describes how to perform the layered print with the metallic silver ink and CMYK ink using the

metallic silver ink as background.
= P. 18, “Blend Print and Layered Print (Metallic Silver and CMYK)”

To perform the layered print, you need to use the printing data where the use of the metallic silver ink and

the CMYK ink is designated.

= P. 12, “2-3 Creating Printing Data”

Procedure

o Make sure that you have finished making the preparations for VersaWorks, getting the
printer ready, and creating the printing data (= page 9, "Chapter 2 -- Getting Ready").

O 5
Roland VersaWorks

File(F) Edit(E) View(V) Jeb()) Printer(P) Media(M) Help(H)

| XC-540MT

Statuo Ready to Print

=gl 3
8 ’ ‘ tedia Type :

Pririt Cuiality :

I Generic inl |

" High Quality
& Standard
" High Speed

@ I— Blualitu S sfting

ﬂedia Type:

I Generic iryl |

Generic Vingl Il
Generic Vingl || [MT]
Gieneric Banner |

I AESELL IR IRAT FE L FIm

Print Quality :

€ High Quality
" High Duality [Lapered)

Rezalitinn -

Adiustment

17201 14401 i

- Mode :

File Format

Ta I

26 Chapter 3 Printing
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Double-click @
Queue A Properties" window appears.

For [Media Type], select names with [MT]
attached such as "Generic Vinyl 1 [MT]".
Make the selection that matches the media to be
used. Selecting an item attached with [MT] enables
you to choose the print mode that can use the me-
tallic silver ink.

For [Print Quality], select [High Quality
(Layerd)].

If [Mode] is selectable, select [Mt -> CMYK
(V)1
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3-1 Print Job Setting

Calar

(4 e ‘ Click Tt .

& |
File: Farrnat
=

o

‘ Dretailz |

~Spot Colors
IV Corvert Spat Colo

o Dl | ‘ Turn on the [Convert Spot Color] option.

(5] | L=l Click & .

Cut

Cantrals
=
A . .
@] = In [Operation Mode], select the operation
r— Cutting Option: .
Operation Mode : IPrinl & Cut j Of the prl nte r.
Lt Fiint & Cut
oo [ Cutall Paths
I~ CutImags Boundzdt Ol
Mualbn | | ™ Retumn to Origin After Print
(6) @ Click [OK] to close the "Queue A Proper-
WL ties" window.

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings,
refer to the online help provided for VersaWorks.
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3-1 Print Job Setting

Layered Print (CMYK = Metallic Silver)

This section describes how to perform the layered print with the metallic silver ink.
= P. 18, “Blend Print and Layered Print (Metallic Silver and CMYK)”
To perform the layered print, you need to use the printing data where the use of the metallic silver ink and

the CMYK ink is designated.
= P. 12, “2-3 Creating Printing Data”

Procedure
o Make sure that you have finished making the preparations for VersaWorks, getting the
printer ready, and creating the printing data (= page 9, "Chapter 2 -- Getting Ready").

Double-click @
Queue A Properties" window appears.

(2]

Roland VersaWorks
File(F) Edit(E) View(V) Job({)) Printer(P) Media(M) Help(H)

1 XC-540MT

Statuo Ready to Print

9 ’ |-:||n|\} | Media Type : Click
I Generic Vinyl | ;I
Print Quality . High Quality
@ Standard
" High Speed
|
[ ity Setie . “ For [Media Type], select "xxx[MT]: Clear
edia Type : A " " H
ESP L] G PET i | PET Film" or "xxx[MT]: PET Clear Film,
B | Al Adhesive" (or xxx: Clear PET Film," "xxx:
- PET Clear Film, Adhesive).
R R *yxx" indicates “ESP-CL” and others.
SFPLF : Front Print Backlit Filrm
Dire| ESP.CL: Clear PET Fin
| ESP.CL [MT]: Clear PET il
il LJI4SRELT FET Clear i, Adhedive |
........... I TESE-LL M LIRS e | FIm LI . . . .
R | For [Print Quality], select [High Quality
Dually & High Qualty Lapersd) (Layerd)].
Ad‘E?t'fn'Bnt Resnhfinn | 720 % 1440 doi -1
. Made : [Mrs oMvE ) sPasse x| For [Mode], select [CMYK -> Mt (V)]
Mt > CMYK [i] +PASS v2
B (Deta"s CHITI > Mt v PAG5 2

28
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‘ Dretailz |
=
Bl |
~Spot Colors
I Convert Spat Color
e | =
Printer
Cut
Cantrals
. ==
——
@ ,_Euttmg Option:
Operation kode IPrinl & Cut ﬂ
Lt Fiint & Cut
[ Cutall Paths
I~ CutImags Boundzdt Ol

| | ™ Retumn to Origin After Print

3-1 Print Job Setting

Click "2 .

Turn on the [Convert Spot Color] option.

Click B .

In [Operation Mode], select the operation
of the printer.

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.

ta Queue roperties
Quevie A Properti
I8
 Media Settings
; Size: -
et ize: | CustormROLL ~|
;) Gt Media 'width
=
_rh Frarm : I j to I j
Cutl Tie Spacina: 400 = mm
Controls " Mitor
@ Orientation : I b
o [ = (@ (=
M ananement

Click AL .

Turn on the [Mirror] option.

When the printing data with mirror image
is prepared beforehand, you do not need
to turn on this option.

ariable
Data

.

Click [OK] to close the "Queue A Proper-
ties" window.

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings,
refer to the online help provided for VersaWorks.

Downloaded from www.Manualslib.com manuals search engine

Chapter 3 Printing 29


http://www.manualslib.com/

3-1 Print Job Setting

Printing Only with White Ink

This section describes how to perform printing only with the white ink. To use the while ink in printing, you
need to use the printing data where the use of the white ink is designated. If the printing data have the portion
designating the use of other colors, with the setting described in this section, you can print with the white ink
only the area of the image which has been designated to print with the white ink.

= P. 12, “2-3 Creating Printing Data”

Procedure

ake sure that you have finished making the preparations for VersaWorks, getting the
@ mak that h finished making th ti for Vv Work ing th
printer ready, and creating the printing data (= page 9, "Chapter 2 -- Getting Ready").

(2]

Roland VersaWorks

File(F) Edit(E) View(V) Jeb()) Printer(P) Media(M) Help(H)

1 XC-540MT

Statuo Ready to Print

=g
| =ik izl Type ;
I Generic Vingl | ;I
Frint Quality " High Quality
@ Standard
" High Speed
1~ Buality 5 etting:
Media Type :
ESP-CL [MT]: Clear PET Film LI

Print

Nt S6.TR

ESP-CL

Frinter
Cantrols

[BT]: S e able
SFPLF : Frant Print Backlit Filrn
DIl 8P CL Clear PET Film
SP-CL[MT]: Clear PET Film
I~ 15P-CLT : PET Clear Film, Adhesive
e, L.

©O 1T (hAT1. OCT Ol Ci

Generic Vingl |
Generic Yingl | [MT]

' High Quality
" High Qualiy [Layered]

17900 1440 i -1

CHYEME [v] +PASS

CMYKME [v] +PASS

ChYKME [] antwdhite +PASS
ChVKME [v] underw/hite +P455
‘bt <> CHTEME [v] +PA552
CHYEME - White [v] +PASS 2
MetallicSilver [+v] +PASS

ChVK.

@ Print Guality :
Ouality
Colar :
Adjustment Do
Mode :
—Detailz
Fils Format
Halftone: :
Interpalation :
| e =
30 Chapter 3 Printing
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Double-click @
Queue A Properties" window appears.

Click =

For [Media Type], select “xxx[MT]: Clear
PET Film” or “xxx[MT]: PET Clear Film,
Adhesive” (or xxx: Clear PET Film,” “xxx:
PET Clear Film, Adhesive).

*“xxx" indicates “ESP-CL" and others.

For [Print Quality], select [High Quality].
When “xxx: Clear PET Film” or “xxx: PET Clear Film,
Adhesive”is selected for [Media Type], [Print Quality]
need not be selected (because the option is only
[High Quality]).

For [Mode], select [White (v)].
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e | =
Printer

Cut
Cantrals

| =

—

AL

Layout

Mualibn

Wariable
Data

‘ Dretailz |
Bl |
~Spot Colors
I Convert Spat Color
,_—Euttmg Option:
Operation kode IPrinl & Cut ﬂ

Frint & Cut
T CutalPas m_ d
I~ CutImags Boundzdt Ol

| | ™ Retumn to Origin After Print

6 |E
|

3-1 Print Job Setting

Turn on the [Convert Spot Color] option.

In [Operation Mode], select the operation
of the printer.

Click [OK] to close the "Queue A Proper-
ties" window.

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”

Only the settings necessary for the use of the metallic silver ink are described in this section. For other settings,
refer to the online help provided for VersaWorks.

*If you select [CMYK (v)] for [Mode] in the procedure 9 only the area of the image where CMYK is specified
in the printing data is to be printed.
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3-1 Print Job Setting

Printing with While, Metallic Silver, and CMYK Ink

This section describes how to perform printing with the metallic silver ink, the white ink, and the CMYK ink.
Deciding which ink between the white and the others (the metallic silver and CMYK) you want to use for the
base is an important point in determining the print job setting here.
To use the metallic silver ink and the white ink, you need to use the printing data where the use of the respec-
tive inks is designated. For the area of the image to be printed with the metallic silver ink and the CMYK ink
combined, the setting is fixed to the blend print.

= P. 12, “2-3 Creating Printing Data”

Procedure
o Make sure that you have finished making the preparations for VersaWorks, getting the
printer ready, and creating the printing data (= page 9, "Chapter 2 -- Getting Ready").

9 P D ouble-click @

File(F) Edit(E) View(V) Job() Printer(?) Media(M) HelptH) Queue A Properties” window appears.

1 XC-540MT

Statuo Ready to Print

9 ’ ;”m o ‘ Media Type:
IGenelic Wil | LI

Print Qualiy - High Quality
@ Standard
" High Speed

I
Hualiby Settina: .
l&é} ‘F MedllaTy:e ! “ For [Media Type], select “xxx[MT]: Clear

ESP-CL [MT]: Clear PET Film ~] PET Film” or “XXX[MT]: PET Clear Film,
P Cene ot | (4T] Adhesive.”
*"xxx" indicates “ESP-CL" and others.

Sl Wratle
Di SFPLF ant Frirt Backllt F\Im
L ESP-CL: Clear F‘ET F\m
SP-CL [MT]:

Printer

Cantrols |
‘ 55 T e I For [Print Quality], select [High Quality].
Qusity € High Gualty [Layered) With [Mode], select the print mode.
% White -> CMYKMt (v)
B e TS = Inks are overprinted in the sequence of white and
:‘ [ bode: CHYEM: [+) +PASS =] then metallic silver/CMYK Color.
- DT EMYKML o it +PASS CMYKMt -> White (v)
Halftane ChAvEME [ nderhlte +PA5 . . f .
it [y Inks are overprinted in the sequence of white and
+Ii CMYEML - whie [v] +PASSV2 .
i MetelcSiver 1] P45 then metallic silver/CMYK Color.
[w] +PASS
Maik. Interpolation :  [white [v)] W-PA5S
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3-1 Print Job Setting

Image of overprinting in the sequence of white and then metallic silver/CMYK Color
(Print Mode "White -> CMYKMt (v) ")

[Transparent film

The printed image is to
be seen from this side
(the printed surface of
the finished results).

Metallic silver/CMYK J

* The white data and the metallic silver/CMYK color data are actually printed simultaneously, but they are
shown here as separate layers in order to indicate the printing sequence.

Image of overprinting in the sequence of metallic silver/CMYK Color and then white
(Print Mode "CMYKMt -> White (v) ")

[Transparent film

The printed image is to
be seen from this side
(the opposite side of the
printed surface of the
finished results).

~ Metallic silver/CMYK )

(white ] o

* The white data and the metallic silver/CMYK color data are actually printed simultaneously, but they are
shown here as separate layers in order to indicate the printing sequence.

Chapter 3 Printing 33
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3-1 Print Job Setting

o

Details

e |

‘ Click Tl .

Turn on the [Convert Spot Color] option.

- Spot Colors

J¥ {Conver Spot Colo;

6 | =N Click B

Cut
Contrals

- . -

@] = <~ | In [Operation Mode], select the operation

Cutting Option: .

|’DDeratinn Mode IPnnt & Cut ;I Of the prlnter'
Layout -
Prirt & Cut

T Cutl Pahe w_ d

I~ CutImage Bound=dh 00k
Dualibn | | ™ Return to Origin After Print

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.
' Queue A Properties 7 Iﬁl@ CIiCK @ .
e
' Y i
ﬁ‘-‘ﬁ — Media Settings
Laut Size: [CustomROLL -]
%)‘ Get Media w/idth
E CCER (R ~— T = Turn on the [Mirror] option.
f: Tis Soacing: [300 =1 nm When the printing data with mirror image
C“@SS is prepared beforehand, you do not need
1 Orientation [Iﬁl [‘ to turn on this Optlon.
Mananement

Yaniable

Ea_f-,_'»}.-
Data

Click [OK] to close the “Queue A Proper-
ties” window.

.

| S
o=

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”
Only the settings necessary for the use of the metallic silver ink and white ink are described in this section. For
other settings, refer to the online help provided for VersaWorks.
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3-1 Print Job Setting

Printing with White and CMYK Ink

This section describes how to perform printing with the white ink and the CMYK ink. Deciding which ink
between the white and the CMYK you want to use for the base is an important point in determining the print
job setting here. To use the white ink for printing, you need to use the printing data where the use of the
white ink is designated.

= P. 12, “2-3 Creating Printing Data”

Procedure

0 Make sure that you have finished making the preparations for VersaWorks, getting the
printer ready, and creating the printing data (= page 9, "Chapter 2 -- Getting Ready").

Double-click @

Queue A Properties" window appears.

9 Roland VersaWorks

File(F) Edit() View(V) Job() Printer(P) Media(M) Help(H)

1 XKC-340MT

Btatis :Rgady o Print

ke
@f m.@

(3 A

Lapout

— Quality Setting:

Click &=
hedia Type :
Generic Vingl | ;I

Print Quality: € High Quality

% Standard
" High Speed

I— Quality S etting: ‘
(M edia Type )
ESP-CL [MT]: Clear PET Film ;I

= Generlc Vlnyll
Frirt || [MT]

Quiality

27
™

For [Media Type], select “xxx: Clear PET
Film” or “xxx: PET Clear Film, Adhesive.”
“xxx"indicates “ESP-CL" and others.

Lapout

= PR ECP L - CearET i
. ESP-LL [MT]: Clear PET Film
Printer SP-CLT : PET Clear Film, Adhesive
Cantrols it
S Bt Co = With [Mode], select the print mode.
ustrnert
:‘ Mode : CHYE [v] +PASS =l White -> CMYK (v)
EMYE [v] -FA5S . . .
S| | Lol CMK [v] i P45 Inks are overprinted in the sequence of white and
EMY L | undertihite +PASS
Halftone .
K, ] +P
CMYK > Whie ) $PASEV2 then CMYK Color.
. White [v] W PASS CMYK -> White (v)
Mark

Inks are overprinted in the sequence of CMYK and
then white Color.

* The image of overprinting in the sequence of white and CMYK is the same as that of overprinting in the

sequence of white and metallic silver/CMYK on page 33. (The description of “metallic silver/CMYK” is to
be replaced with “CMYK” only.)
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3-1 Print Job Setting

(4] Click T .
‘ Detals
FUARER] Lol |
W Turn on the [Convert Spot Color] option.
J¥ {Conver Spot Colo;
I
o
click B .
Tt
Controls
— - -
<~ 1| In [Operation Mode], select the operation
E Cutting Option: f th . t
Operation Mode : IF‘nnt&Cut ;I o e prln er.
Laot Frrt & Ct
[~ Cutal Paths m d
[ Cutlmange Boun Cut Only
| | ™ Return to Origin After Print

When You Want to Display the Side Opposite the Printed Surface by Using Clear Film.

= P.29
(6] EE Click [OK] to close the “Queue A Proper-
VSrL.atI;Ie ties” WlndOW.

This is the end of the print job setting. To start printing, go on to page 37 “Starting the Print Operation.”
Only the settings necessary for the use of the white ink are described in this section. For other settings, refer
to the online help provided for VersaWorks.
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3-2 Starting the Print Operation

Starting the Print Operation

Following the print job setting, you can start the print operation.

Procedure

0 Make settings for the print job.
= P. 22, “3-1 Print Job Setting”

9 ] | Go to “Job List,” click the “Queue A”
e [ Jab Nome Tirpet Tone tab, and drag the printing data to the
- Job List $C-540MT queue A job list (If the print job setting
HQuzue s {_Oueun B has been made in [Queue B], drag and
— drop the printing data on the job list of
| | [Queue B].).

The contents of the data are displayed in the preview window, and the layout on the media is displayed
in the layout window.

B Roland VersaWorks [=EErE=]
File(F) Edit(E) View(V) Job()) Printer(P) Media(M) Help(H)
- < |
Job List XC-540M |
( B\
o XC-540MT ﬁ L | I I L 1

Status :Ready to Print

@ (e = wN ) w 3 m
Status | Job Name | Mick Mame w
Print Status =
FIP Status o f . N )
vl o Areas using “RDG_MetallicSilver
e Name el e . :
—— = Creation Date g/ 9/2009135255 | OF spemal metallic color (RVW-MT—
tatus | Job Mame nput Time B . .
= T R ® Nk Bronze, etc.) are displayed with shad-
/ Oueued ' OueusB Document Information H H
01.ps File Type PostScript File Ing In transparent gray
# of Pages 1
Page Size 800 50.0 mm .
Spocel lers Areas using “RDG_WHITE” are
s Pt displayed with shading in transparent
Media Mame Generic Yinyl |
Fint Qualiy Standard ' magenta'
Caolor Settings Pro3v2EcoMH_GenPYCT_vad..
Color Adjustment Linear (Mot Edited)
Scale 1700%
# of Copies 1
H#of Tiles 1
Mark/Label Disable
Fiint &rea 1361.5 % 851.6 mm
Action After Print Sawe.Job
- N } 5y
- PRI 4
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3-2 Starting the Print Operation

9 J

Status | Job Name | Input Time
- Job List %C-540MT
/' Oueued ' OueueB

samplell.ps

5K () R

Delete

File Name
Creation Date
Size

Document Inform
File Type
# of Pages
Page Size
Special ltems

Job Properties
Media Hame
Print Quality
Calor Settings
Color Adjustment

Scale

B of Copies

H# of Tiles
MarkALabel
Frirt Area
Action After Prink

Select the print job in the job list, and then
click [T,
Printing will be started.

After printing, allow the ink to dry sufficiently.
We strongly recommend performing lamina-
tion.

To continue printing similar data, repeat steps 9 and 9 Also, if you want to modify detailed set-
tings for each job, it will be convenient to perform modifications in the “Job Setting” window (which
you can display by double-clicking the print job in the job list).

Printing a Metallic Color Chart

The Metallic Color Chart s the printing sample of the special metallic color. By printing the Metallic Color Chart,
you can confirm the “complete metallic color chart” representing the special metallic color itself that can be
printed with “Your Printer” and “Your Media” (slight pattern differences is possible to occur depending on the
conditions of the printer and media.) By selecting colors from this color chart and creating illustrations with
these colors, you can accurately reproduce the desired colors..

Procedure

o Make sure that you have finished making the preparations for VersaWorks, and getting
the printer ready (= page 9, "Chapter 2 -- Getting Ready").

9 Roland VersaWorks

) XC-340MT

Eta+os :Rgady to Print
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Duality Setting:
Media Type

I Generic Vinwl T [MT]

Print Quality: & High Quality
1~ High Quality [L

ayered)

:
|

Cancel |

3-2 Starting the Print Operation

Click =2 , configure the settings in [Quality-
Settings] and [Color Management].
= P. 22, “3-1 Print Job Setting”

Click [OK].

When printing a Metallic Color Chart, the [Quality] settings from the [Queue Properties] window are
always applied. Since you cannot change the quality settings for the job using the [Job Settings]
window after it has been added, be sure to configure the settings in the [Queue Properties] window
before performing the following operations.

0 pum

File() Edit(E) View(V) Job(J) Printer(P) [ Media(M)| Help(H)

Media Explorer(W)
L XC-340MT

Satus Secondary Pawer OFF Color Chart Type-1

N

Prirt Status Metallic Color Chip:

AIP Staius &=0

Print Roland Color System Library

s

@ = Color Chart Type-2
Color Selector
X | @ Color Chips b
@ it Bt Mt i System Libray

Metallic Color Chart

Status | Job Name [ metame coror seieetor

Print Roland Metallic Texture System Library

T File Al

The following job will be: printed
Do you want to continue?

Page Size: 727.9x G614.9mm= 1P l@

nbutes

Status| Job Mame
Job List WS-640

[Tnput Time:

Downloaded from www.Manualslib.com manuals search engine

@ Click [Media] and then [Metallic Color
Chart].

@ Check the page size.

If the size of the media loaded on the printer is not
adequate for the page size, change it to another
media of sufficient size.

@ Click [OK].

The print job of the Metallic Color Chart is added to
the job list.

Click [@]

Printing will be started.
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4-1 Pullback printing

Pullback printing (White = Metallic silver/CMYK)

This section describes how to perform printing in the sequence of white and then metallic silver/CMYK color.
After performing printing using white ink and allowing the ink to dry for a predetermined period, the media
is pulled back once, and then the fill overprinting is performed using metallic silver and CMYK ink.

The printing data containing metallic colors such as "RDG_MetallicSilver" and "RVW-MT-Bronze" must be used

in order to use the metallic silver ink, and the printing data containing "RDG_WHITE" must be used in order
to use the white ink.

= P. 12, "Creating Printing Data"

(IMPORTANT! )

This printing method involves some important notes for avoiding contamination on the printed
surface. Be sure to refer to page 6, “When Performing Pullback Printing”.

Image of overprinting in the sequence of white and then metallic silver/CMYK

[Transparent media ]

You will have the print- — "
ed image from this side ‘

(the printed surface of \ ) :

the finished results). A !

[ Metallic silver / CMYK |

1. Printing With White Ink Only

o Make sure that you have finished making the preparations for VersaWorks, creating the
printing data, and getting the printer ready (= p. 9, "Chapter 2 Getting Ready").

9 Roland VersaWorks : - DOUbIe'CIiCk @-
File(F) Edit(E) View(\) Job() Printer(P) Media(M) Heﬂ "Queue A Properties" Window appears.
|| XC-540MT

Statoe Ready to Print

@ rx
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— Quality Setting
Media Twpe :
IGeneric Winl | LI
Print Quality: ¢ High Quality
& Standard
 High Speed
Tae |
%é ’ = (el Gttt
f Media Type : N
Layout
ESP-CL [MT]: Clear PET Film =l

. | Generic Yingl |
Piint § 5 ereic 4inl | [MT]
W

Frirter
Caontrols

Tt
| ‘ Guality
Adjustment

5

File: Foimat

Frinter
Cantrals

|

.| SFPLF : Frant Print BACKITF ilm
Dire| ESP-CL : Clear PET Film
ESP-CL [MT]: Clear PET Film
SP-CLT : PET Clear Film, Adhesiv
SP-CLT [MT]: PET Clear Filrm, Adhesive

I

k GYWG : Manomeric Calendered Self Adhesive

Frint Quality: & High Quality

€ High Quality [Layered)

Resnltinn: 172011440 dni vl
(Mode : CMYKME [v] +PA55 |
e CHYEMI [v] +PASS
Dietietls CMYKML [v] oriwhite +PASS
P CMYEML [v) underahite +PASS
; Wwhite > CHYEME [v] +PASS2
CRATVKME -5 Wit [v] +PA55w2
MetallicSikver [v] +PASS
] CRAYE [i] +PA:
\Interpolatlon B it ]
| Iirerhan - el Yrechian -l

‘ Rttt = |

“acuum Power ; I Strang i l
I 0 s l Minutes

Lo e

Dy Time :

Head Height :

e =]

‘ ~Heater Cantral
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—— —_
Dy Tirne: : ﬂ Mirute
i
Head Height : vl
- | leater Contrals

4-1 Pullback printing

For [Media Type], select "xxx[MT]: Clear
Film" or "xxx[MT]: Clear Film, Adhe-
sive."

*xxx" indicates “ESP-CL" and others.

For [Print Quality], select [High Qual-
ity].

With [Mode], select the print mode "White

(v) .ll
This prints with RDG_WHITE only.

Click & .

With [Other Controls], select “User Cus-
tom Settings.”

For [Dry Time], select “15 minutes.”
This is a suggested setting for when using an
auxiliary drying unit (the DU-540).
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4-1 Pullback printing

(5]

1= ‘

Frinter

I—(Cutting Optian:

Operation Mode :

[T Cut &)l Paths
™t Irnane Banr,

1

Guality

e

no oo

Operation Mode

[T Cut Al Paths

I~ it lrnzne Boowd sras

IF'nnt Only

Frint & Cut

Cut Only

P

IF'lint Only LI

@ Feturn to Origin

After Print )

=TT

T Frahle ddvane

TG

arl Sattinns

Click B .

In [Operation Mode], select “Print
Only.”

Turn on the [Return to Origin After Print]
option.

When You Want to Display the Side Opposite the Printed Surface

Queue A Properties EI =N
e
— Media Settings
n =
Lepand Size: | CustomROLL ~|
..... Get Media width |
e
_[-A- frar : I :ll ta: I ::ll
Cut . Tile Soacing : Id oo : mm
Controlz (|7 Mirar
&i" Orientation : [@ [@ [ '[ 1
Job
b ananement

Click (AL .

Turn on the [Mirror] option.
When the printing data with mirrorim-
ageis prepared beforehand, you do not
need to turn on this option.

NOTE: This section only described the settings that are necessary for the use of the white ink. For other set-
tings, refer to the online help provided for VersaWorks.

Wariable
Data

e |

44
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Click [OK] to close the "Queue A Proper-
ties" window.
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Statug |.Job I arne:
- Jab List =C-540M 7

| Input Time

GQuele B

Queue s

4-1 Pullback printing

Go to “Job List” and click the “Queue
A” tab, and drag the printing data to the
queue A job list.

The contents of the data are displayed in the preview window, and the layout on the media is displayed

in the layout window.

Job Properties
Media Name:
Frint Quality
Color Settings
Color Adiustment

Scale

# of Copies

#of Tiles
Mark/Label
Fiint érea
Action Alter Frint

ESP-CL [MT]: Clear PET Fiim
High Qlualty

Linear (Mot Edted]

17007

1

1

Dizable

1361.5 % 8516 mm
Save.oh

—

e

Status | Job Name
- Job List <C-540MT
" Queued | DueusB

. | Input Time Size

sampledl.ps

s van

Creation

Documen
File Typt
# of Pag
Page Si
Special |

Scale

# of Cop
# of Tile
MarkdLz
Frint Are
Action &

click

Printing will be started.
After printing and dry time, the media is pulled
back. Continue printing of areas using metallic

silver and CMYK colors.

Job Prope
Media N
Frirt Cu.
Calor Se
Calor Ad
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———————————]
i Roland VersaWorks [E=E[EcE (<=
File(F) EditE) View(¥) Jobil) Printer(P) Media(M) Help(H)
7 N N
( B\ /A e S
1 XC-540MT _h B B e
Status :Ready 1o Print
@ ﬂ N f |
[ Y & .
] = (AR DG
T= = .\, R e a0
Status | JobName || Hick Name 5 A NcE W
Print Status E
RIP Status -
File Attributes . “ ”
i s Areas using “RDG_WHITE” are
Creation D ate 9/ 9/2003 14:02:58 H H H H
s s Ee ek displayed with shading in transparent
- WJabr List XC-540MT
/ Gueued ' OueueB Document Information ma enta
01 ps 402 File Type PostScript File
# of Pages 1 |
Page Size 80.0%50.0 mm
Special ltems

Select the print job in the job list, then

45
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4-1 Pullback printing

2. Printing With Metallic Silver/CMYK Color

0 Double-click the print job that was used in the step /.
The "Job Setting” window appears.

Roland VersaWorks EIEIE)

File(F) Edit(E) View(V) Job()) Printer() Media(M) Help(H)

|- Job List XC-540MT
: W @@

[ XC-540MT

Status :Ready to Print

1 a8 I £ @ [ a0 1050 1200 =
@ [ MedoSetings |

Size+ [CustomAOLL =
Layout ki I ustem! J -
Bat Mediawidth
Status | Job Name wo [T86760 =] mm H: 000 = mm E
P Buality
 Scaling
Scals = =z g e “ .
RIP) Colar = -
Achsient b =inBit il E H | J .r’ -
[ Fitto Media Size = s ‘_J .
Status | Job Name = ~ Pasition E = = .
~ | FieFomat H
; x: 000 S v [0 g o e T
S I Center on the Mecia A
- Print Prog
= || o =3 e

i ™ Page Range

Phinte
Controls — — E
(&) fiom = = KA &

‘E'L‘l'[" Tile Spacing: [4.00 _,::' mm B
Coniols I Miror
o =
5‘7\ Orentation [@ §
Job

Management E

e

E

@E Chz{nd;i\e

Delete
—
Pk

s

Wariable S
Data 4 3
‘ Cancel
9 < When performing blend print with metallic silver / CMYK >
% — Guality Setting:
! . Media Type : Click .
|ESPELMT]: Clear PET Fim = For [Print Quality], select [High Qual-
Print Quality: ¢ High Quality ity]
" High Quality [Layered)
E l =] I ki ~ i - H -
St ’f — ' 1‘ With [Mode], select the print mode "
-. ode : ICMYKMI[V] +PASS LI CMYKMt (V) OnWhite "
] Details LMK [+] 255 )
§ ChEME ] oriwhite +FA i i i
File Forma e CMYKME ] cndevitte +PA55 This prints the areas where metallic color, such
EAEI S whie ) s as RDG_MetallicSilver and RVW-MT-Bronze, and
= R CMYK colors are specified.
nterpoiation s |white [v) W-PASS
N e J
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4-1 Pullback printing

< When performing layered print with metallic silver / CMYK >

% — Guality Setting

T Media Type :

IFSP.M IMT1- Clear PET Filn -l

Print Quality: ¢~ High Quality

Quality ) " High Qualty [Layered)
e Resaluion (72051440 doi -1

: Mode : | Mt CHIYK [v) +PASEv2 ~|

: it >
Details

FoFama |\ L EMYK > Mt [v] +PASSV2

=
Guality

o

b=l

gy B

==

Frinter
LY

File: Fiarmiat

ol

Iark

miE=

=

Frirter

Quality

4

\ Cantrals )

Details |

= 1

('7 Convert Spot Calar )

Jm e e e e )
“acuum Power ; lm
Dy Time : m Minutes
Head Height : Law 4

~Heater Cantral

[ Other Control

IUse Cusztomn Settings j
[Uze Default Media Settings |

|

| Use Printer Settings

|
I 0 LI Minutes

Diry Time -

’ [~ Cut&ll Paths

I ok lrmsna Brondsrias

(l_ Fieturn to Origin After Print )

TR =TTy

™ Frahle fdvancad Settinns
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For [Print Quality], select [High Quality
(Layered)].

With [Mode], select the print mode "Mt
-> CMYK(v)."

This prints the areas where metallic color, such
as RDG_MetallicSilver and RVW-MT-Bronze, and
CMYK colors are specified.

Click Tt .

Turn on the [Convert Spot Color] op-
tion.

Click & .

With [Other Controls], select "Use De-
fault Media Settings."

Click &/ .

Turn off the [Return to Origin After Print]
option.
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4-1 Pullback printing

YWariable ‘

Data
e |
| e rais
Creation Date
Status | Job Name | Input Time: Siam
- Job List KC-540MT
/ Oueued ' OueueB Document Information

sample0l.ps

(@) oS

Delete

File Tupe

# of Pages
Page Size
Special ltems

Job Properties
Media Name
Prirk Quiality
Color Settings
Color Adjustment

Scale

# of Copies

H of Tiles
tark/Label
Frint Area
Action After Print

Click [OK] to close the “Job Setting”
window.

Select the print job in the job list, then
click [TH.
Printing will be started.

After printing, allow the ink to dry sufficiently.
We strongly recommend performing lamina-
tion.

clicking the print job in the job

When continuing printing using another data that uses metallic silver, white, and CMYK colors,
repeat steps on and after /.- @. Also, if you want to modify detailed settings for each job, it
will be convenient to perform modifications in the“Job Setting” window (displayed by double-

48 Chapter 4 Advanced
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4-1 Pullback printing

Pullback printing (Metallic silver/CMYK = White)

This section describes how to perform printing in the sequence of metallic silver/CMYK Color and then white.
After performing printing using metallic silver and CMYK ink and allowing the ink to dry for predetermined
period, the media is pulled back once, and then the fill overprinting is performed using white ink.

The printing data containing metallic colors such as“RDG_MetallicSilver” and “RVW-MT-Bronze” must be used

in order to use the metallic silver ink, and the printing data containing “/RDG_WHITE” must be used in order
to use the white ink.

= P. 12, “Creating Printing Data”

(IMPORTANT!)

This printing method involves some important notes for avoiding contamination on the printed
surface. Be sure to refer to page 6, “When Performing Pullback Printing”.

Image of overprinting in the sequence of metallic silver/CMYK and then white.

[Transparent media ]

You will have the
printed image from this
side (the opposite side
of the printed surface
of the finished results).

1. Printing With Metallic Silver/CMYK Color

0 Make sure that you have finished making the preparations for VersaWorks, creating the
printing data, and getting the printer ready (= p. 9, "Chapter 2 Getting Ready").

9 Roland VersaWorks . _— DOUble-CliCk @.
File(F) Edit(E) View(V) Job()) Printer(P} Media(M) Hew "Queue A Properties“ window appears.
) XC-340MT

Statue :Ready to Print

Y i = =
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4-1 Pullback printing

@ < When performing blend print with metallic silver / CMYK >

[&% r Duality S etting:
e Media Type :
I Generic Winyl | LI
Frint Quality: ¢ High Quality
* Standard
" High Speed
%&1 ’(r“"""““""“ ~N For [Media Type], select "xxx[MT]: Clear
tdedia Tppe . " " . H
ESP oL ] CewPET i El Film" or "xxx[MT]: Clear Film, Adhe-
. [Geneic Vinl | i "
Print aZEZIEEv@Eﬁu[w Sive.
! ~  ““xxx"indicates “ESP-CL” and others.
b - . Py
= . _|SFPLF : Front Print B3 il
= Dire ESP-CL : Clear PET Film
Printer I~ 1g5P-CLT : PET Clear Film, Adhesiv
Centialh SP-LLT [MT]: FET Clear Film, Adhesive
By U 5E  Mommere Canded Sefpchesive Y] | )
o —r e =
| = I | For [Print Quality], select [High Qual-
Quality ~ High Quality [Layered) ity]_
AdiEgtll?;enl Dasnkbice - 1790 01440 dni -l
.. [ CHIVEM: [v] +F55 = With [Mode], select the print mode "
el | It EMrK: ] ot CMYKMt (v) underWhite."
filtene This prints the areas where metallic color, such
CHYEME -> White [v] +PAS52 . .
gﬁt\?'lgc[s]ﬂvg (1) +PASS as RDG_MetallicSilver and RVW-MT-Bronze, and
N H
Interpolation:  |whits [v] W-PASS CMYK colors are specified.

=g )
’ P ‘ Media Type :
I Generic Yinyl | LI
Print Quality: ¢ High Quality
" Standard
" High Speed

o
AL TR, | For [Media Type], select "xxx[MT]: Clear

ESPCL V] Con PET Fim E PET Film" or "xxx[MT]: PET Clear Film,

o - Adhesive" (or xxx: Clear PET Film,"™ "xxx:
- PET Clear Film, Adhesive).

*“yxx" indicates “ESP-CL” and others.

PESG-TR [MT]: ST —relic

. _|SFPLF : Front Print Backlit Film

Ditel E cpCy: Clear PET Film
ESF-CL [MT]: Clear FET Film

I~ 1JSP-CLT : PET Clear Film, Adhesive

CO T (hAT1 - DT e Dl b Alnis e

Frirter
Canrols

I
| o e = . . . .
S P y | For [Print Quality], select [High Quality
Dually & High Dualty [Layer=d) (Layerd)].
Ad‘Egt'fn'Bm Fesnlfinn - | 720 1440 doi -1
. Mode : [Me Covk vy spassve ~] For [Mode], select [CMYK -> Mt(v)].
B | K b o) o This prints the areas where metallic color, such as
va 1IN e — RDG_MetallicSilver and RVW-MT-Bronze, and CMYK
colors are specified.
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-

@ Calar

File: Format

— ‘

Frinter
Controlz

D etails |

s e :

Wacuumn Power : IStrong 'l
ID 'I Iinutes

Head Height : Low -

Diry Time :

(|7 Coreert Spot Colar )

Y T
gizhena ’ r~ Other Coritral
fl Usge Custom Settings LI
U ze Default Media Settings
1 5 - I
& Lse Printer Settings
= | | - s Minules
s e e =
E Diry Tirne : 18 'IM\nule
. 0
Printer Head Height : [
Contrals B =~
[-Ar)', r Mleater Controls
Cut
Cantrals 1= =dan @
0 | o
Frinter
()
Cu
Contralz
——
@ r(—Culling Option:
Operation Mode : IPnnt Only ;I
Lapout -
Prrint & Cut
[~ Cut All Paths
Q‘ [t Imane Frnn, Ut Dol
) I
Operation Mode: | Print Orl A
Lapout I Y _I
= [ Cut &l Paths
= L il e R o d i
Cuality 67 Feturn to Origin Afker Print )
% T R T = =TS
[ Frahle drbvanced Satinns
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4-1 Pullback printing

Click &t .

Turn on the [Convert Spot Color] op-
tion.

Click & .

With [Other Controls], select “User Cus-
tom Settings.”

For [Dry Time], select “15 minutes.”
This is a suggested setting for when using an
auxiliary drying unit (the DU-540).

Click B .

In [Operation Mode], select “Print
Only.”

Turn on the [Return to Origin After Print]

option.
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4-1 Pullback printing

When You Want to Display the Side Opposite the Printed Surface

— S
Queue A Properties =l = .
Ve
 Media Settings
Size: | CustomROLL LI
Get Media width |
rA- fram : | j to: I j
i Tile Spacing: (400 = mm
Contralz (|7 i )
&ﬁ\l Orientation: [0 '| |
Job [ [@ @ @
M ananerment

Click@ .

Turn on the [Mirror] option.
When the printing data with mirrorim-
ageis prepared beforehand, you do not
need to turn on this option.

NOTE: This section only described the settings that are necessary for the use of the metallic silver ink. For other
settings, refer to the online help provided for VersaWorks.

(7]

52

YWariable
[rata

e |

Statuz | Job Mame
-

| Input Time
Job Ligt <C-540M T

" Queus s |

QueueB

\am

zampledl.pz

Status | Job Mame
-

[ Queue &

. QueusB

| Input Time
Job List <C-5400T

i

zamplell.ps

Al
0
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File Mz
Creatic
Size

Docume
File Ty
Hof P
Fage !
Speciz

Job Proj
Media
Print 3
Colar £
Colar £

Scale

Hofl
Hof Ti
I ark.|
Frint &
Action

Click [OK] to close the “Queue A Proper-
ties” window.

Go to “Job List” and click the “Queue
A” tab, and drag the printing data to the
queue A job list.

The contents of the data are displayed in the
preview window, and the layout on the media is
displayed in the layout window.

Select the print job in the job list, then
click [T

Printing will be started.

After printing and dry time, the media is pulled
back. Then, print the white areas.
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4-1 Pullback printing

2. Printing With White Ink Only

o Double-click the print job that was used in the step 1.
The “Job Setting” window appears.

Roland VersaWorks EIEIE]

File(F) Edit(E) View(V) Job()) Printer(P) Media(M) Help(H)

= oA EEEDO
E Pr—— R W w m m m . m
‘ e Size: [CustomAOLL | .
Get Media wWidth
Status | Job Name w: [1%160 = mm H: 000 = mm E —
=, Ty -
B LG
BZ || s fEm = £
RIP Cal rs -
o wi [008 = mm H: 003 = mm E
% [¥ Fitto Media Size =
Status | Job Name e i~ Position E
e Forta
- 2 A e R e
:!‘f Iz I~ Center on the Media i
Mark ~ Piint Props
=] Copy 1 | EE
pae I Page Range 1
Eﬁg'”‘s fem: T = e T H
E.?) Tile Spacing: {4.00 _:l mm 5‘
Controls ] (1P
[AC=) Orientat i
e |l i
g [R)
A
Clip and Tile g
= =
sy g
Wariable e
Dats f »
| _owen |
9 — Quality Setting
Media Type :
|ESP-CL[MT]: Clear PET Film =]
Print Quality : £ High Quality X . . .
 High Qualty [Layered] For [Print Quality], select [High Quality].

(o EMYMt (1) +PASS =) With [Mode], select the print mode

CMTKME [v] +FASS

Detailz p .
CMYEME [+] ortafhite +PASS e ”
Halitane : CMYKMt[:] Egder\lv\?hite +PA5S Whlte (V) -
i wihite -» CMYEME [v] 4PA5S2 H H H
CHPKHE > Whits [v] sEAG342 This prints with RDG_WHITE only.

etalicSiver [v] +PASS
Cl

Interpolation :
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4-1 Pullback printing

Frinter
Contrals

L

File Farmat

Cut
Cantral:

Izl

L

Wariable
Data

o i v ey
Wacuum Fower : m
Dy Tirne : lﬂ Hinutes
Head Height : Low i
—Heatear Cantral
P Other Cortral
Use Custom Settings ;I
Use Defaul Media Settings
| Llse Printer Settings | =
Dy Tirne ID LI Minutes

‘ [~ Cut & Paths

i N | e N e i

G_ Feturn to Origin &fter Frint )

R CETIEET—y

™ Frahle Advanred Sattinas

e |

‘ File Name

Status | Job Name

('

/ Oueued

Queus B
samplell ps

Creation Date

| Input Time S

Job List XC-540HT
Document Information
File Type
# of Pages

Delete

25 (&) oD

Fage Size
Special ltems

Job Properties
Media Name
Frint Quality
Color Settings
Color Adjustment

Scale

# of Copies

# of Tiles
MarkLabel
Frint Area
Action After Prink

Click & .

With [Other Controls], select "Use De-
fault Media Settings."

Click@ .

Turn off the [Return to Origin After Print]
option.

Click [OK] to close the “Job Setting”
window.

Select the print job in the job list, then
click [7]
Printing will be started.

After printing, allow the ink to dry sufficiently.
We strongly recommend performing lamina-
tion.

When continuing printing using another data that uses metallic silver, white, and CMYK colors,
repeat steps on and after Z.-@. Also, if you want to modify detailed settings for each job, it
will be convenient to perform modifications in the“Job Setting” window (displayed by double-
clicking the print job in the job list).
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4-2 Performing Texture Printing

What is Texture Printing?

Texture printing is a printing method to produce texture patterns. This uses the texture patterns of the ex-
clusive library to create and output the printing data. This document describes the texture printing using
metallic silver ink.
* Create the printing data using the Adobe Illustrator version of CS or later if using Adobe Illustrator. If you
use the earlier version before Adobe lIllustrator 10 to create the printing data, the texture patterns may
result in poor condition.

Create The Texture Printing Data

To create the data for the texture printing, please follow the instructions below.

The program used to create the printing data is Adobe lllustrator CS4. For detailed information on drawing
methods and how to work with palettes, refer to the documentation or online help for Adobe lllustrator
CS4. If you're using another version of Adobe lllustrator, operations may be somewhat different from those
explained here.

1. Open the exclusive library.

0 At the swatch palette menu, select [Open Swatch Library], then [Other Libraries].
The "Select Library" window appears.
* The swatch palette is displayed by going to the menu and selecting [Window], then [Swatch].

SWATCHES

New Swatch... Art History 3
New Color Group... Celebration
Duplicate Swatch Color Books 3
Merge Swatches Color Properties »
- Delete Swatch Corporate
T Ungroup Color Group Default Swatches 2
Select All Unused B
Add Used Colors oo >
Gradients »
Sort by Mame Kids Stuff
Sort by Kind Matal
Show Find Field Mot .
¥ | Small Thumbnail View Neutral
Medium Thumbnail View Patterns »
Large Thumbnail View Scientific *
Small List View Skintones
Large List View System (Macintosh)
Swatch Options... SiEen Ut wsD).
Spot Colors... Teataes
VisiBone2
Open Swatch Library 3 Web
dve owatcn Liorary as ASE... User Defined »
Save Swatch Library as AlL..
Other Library... ]
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4-2 Performing Texture Printing

(2] (DOpen folder in the order of [Computer] (or [My Computer]) — [Local Disk (C:)] —
[Program Files] — [Roland VersaWorks] — [Swatch] — [lllustrator], and then select
"Roland Metallic Texture System Library.ai."”

Depending on the settings of your computer, the extension "ai" might not be shown.

@Click [Open].

The exclusive swatch libraries “Roland Metallic Texture System Library.ai” is displayed.

4 Select & library to ope

« Program Files » Roland Versaworks » Swatch » Illustrator

Organize ~  New folder
2 ° 512
7 Favorites
P Deskiop il Roland Celer System Library.ai Adobe Tllustrato 175 KB
B Downloay il Roland Grapac Eri-o-coat Library.ai Adobe Tllu 750 KB
1 Recert || i Roland Metallic Color System Library.ai Adobe Tllu 202 KB
i o A e Il 246 KB
3 Libraries i Roland Metallic Texture System Library.ai Adobe Tilu 129 kB
[ T - e
| Documents Adobe Tllustrato 803 KB
& Music Tl Roland versaworks.ai Adobe Tllustrato 46 KB
=] Pictures
H Videos
% Computer
05 (C)
€ Network

ROLAND METALLIC TEXTURE SYSTEM LIERARY

AL A LA -

File name: Roland Metallic Texture System Library.ai A

By saving the "ai" file selected in step 9 into the folder below, you can register the exclusive library
to the Adobe Illustrator's library.

C:\Program Files\Adobe\Adobe Illustrator CS4\Preset\Swatch

("C"is the name of your computer's local disk.)

Once the registration is performed, you can open the library directly from the swatch palette menu,
eliminating the need to search the file every time you start Adobe lllustrator.

56 Chapter 4 Advanced

Downloaded from www.Manualslib.com manuals search engine


http://www.manualslib.com/

4-2 Performing Texture Printing

2. Create lllustrations and Specify Texture Patterns You Wish to Use

o Create the illustration.
Be sure to draw the illustration in the CMYK mode.

9 Assign the desired texture patterns to the areas for the texture printing.
The areas where the texture patterns are assigned shall be printed with metallic silver ink. When the
metallic silver ink is to be used for the printings other than the texture printing, other special spot colors
shall be used. For the detailed usage, please refer to “Chapter 2 Getting Ready”.

|Ai| File Edit Object Type Select Effect View Window Help | el EE~ | essenmais ~ | EHEN - - *

et |:E| stroke:[]10t v @ 10pt ~| styie:| || Opacty:[100  + |9 [ Document

TEXTURE_Sample_03.ai @ 150% (Cl

The area to be printed with the texture pattern
= From " Roland Metallic Texture System
Library," specify the texture pattern such as

| "RTSL-MT-Standard-020."

PChB[ESFNUEES ARBORANND Ao DivE

=]
a

150% - M 4 ERLNN ) Unmanaged Fie K ™=

L)

Preferences | =i [v|

v

1]

ROLAND METALLIC TEXTUR...

LA AAAAA A TAA o
V] P P 2 2V 2 P A A

@ 4 - N

weahtl2 10t | [EEE
el T
Al siroe: |0 LY
[]Dashed tine ———————
(e e e e e

dih asp dwh g dmh o dse

potroke: [l et

=
B O
e
=

1 Layer @ +a @ F

* The name of the texture pattern is displayed on the data of Illustrator. The texture of the displayed image

appears rougher than that of the actual print.
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4-2 Performing Texture Printing

3. Create the PS (PostScript) file.

o {6 [BR] cot obiert e Sdect et view w
ol MNew ctilen
New from Template. Shifte Ctrl+N
[
= Open. [
(]| open RecentFies ,
B | oveeinBidge AeCte0
2 Share My
are My Screen
153
7 Device Centra,
T Close CtrleW
4 Save ciss
O, sevens Shit CtleS
& Savea Copyeu Alt+ Ctrl+s
2 Save as Template.
£ CheckIn
4, Save for Web & Devices. AltsShifts Ctrl+S
o Revert F12
) Place.
'] Save for Microsoft Office...
) Export
), Scripts »
E@ Document Setup At Cttop
1 Document Color Made: ,
@5 Filenfn Alt+Shift Ctris]
< print. > ci+p
Lh e ctleq

print ®

Rolandvw

Roind VersaWorks)

(DClick [Print] from the [File] menu.
@sSelect [Roland VW].
®cClick [Setup].

@Click [Continue].

General
Coples: 1 Colate [ElReverse Order
oAl [T 1gnore Artboards
Range: Skip Blank Artboards
Media
Size:  Defined by Driver - Transverse

Width: |210.058 m| Height: [207.053 m| (&) &) @

Options
‘e Placement: §a§ X: 0.029mm  Y: 0.0265mm
e © Do Not scale
7, wigl
7, it to Page
« Custom Scale: w: [100 ] H: [100
s Ful Pages Overbp: |© 0mm
scale: W:[100 ] H: [100

Tie Range:

W "h
@ Print Layers:  Visble & Printable Layers -

‘Adohbe Tllustrator

The Print Setup dialog box is provided by the operating
system.To ensure that you can use the full print
capabilities of Illustrator, please set all print options
from the Print dialog box.

A

o

[ Centinue )

D/

|1 Don't Shaw Again

Return to Print Dialog |
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4-2 Performing Texture Printing

9 — = DTurn on the [Print to file] option.
ey 5 ®@Click [Preferences].
(®Click [Advanced] in the [Layout] tab.
oot | | B For Windows 2000: In the "Print" dialog
box (the window at the very top of this
e Coa) page), go to the "Layout" tab and click
[Advanced].
' @Click the down arrow to the right of the
s e [Paper Size] box, and then click [PostScript
Custom Page Size] from the list that ap-
pears.
1. ®For "Custom Page Size Definition," en-

ter the values in the "Width" and "Height"
fields.

Enter values for the same size as the illustration you
created in step 2..

B
1CM Mel [ an
IcMinte [

Opti [ ARCHB
<dP [ ARCH C
2ges per St ] ARCHD

PostScript Custom PaE Size wm

Custom Fase Size Dimension: @ Unit
Width: 150 (25 | ON47 00) plincy

—_— ) Milimet
Height: 150 (25 §0, 11557 00) @ p‘ '":e =
ain

Faper Feed Direction: Short Edee First =
Faper Type: Cut Sheat ©) Roll Feed
Offsets Relstive to Psper Feed Direction

Perpendicular Direction: ono 000, 0oy
Paralle| Direction: ono 000, 0003

[ ok | [ cencel | [Restore Defaults

@ Click [OK] three times to close the "PostScript Custom Page Size Definition," "Roland
VersaWorks Advanced Options," and "Printing Preferences" dialog boxes.
The "Print" dialog box returns.
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4-2 Performing Texture Printing

o

@Click [Print].

Select Printer

[ Roland GX-640

 Roland MPX.30 ®CI|Ck [Prlnt]

8 RolandV
« [ i B
Stat. Feady 19 RS HE

Find Printsr.

Fage Range
R Number ofcopies: 1
Selection Gurrent Psge

@

Print
Print Preset:  Custom v
Printer:  RolandVt/ -
PPD:  Defautt (Rokand VersaWorks) -
General
Copies: 1 Colate [FlReverse Order
© Al [CJ1gnore Artboards
Range: Skip Blank Artboards
Meda
Size:  Defined by Driver - Transverse

Width: [150.0847 1| Height: [150.0847 r @ =

Options
Phcement: §al X: 25.0076n Y: 6850761

© Do Not Scale

Fit to Page

Custom Scale: w: [100 ] H: [100

Tie Full Pages Overtap: 5 0 mm
Scale: W [100 ] H: [100

\nge
CRETI) »
print Layers: Printable Layers -

>0

6 @3@ DSpecify the destination and file name for

) cesrE saving, then save the file.

T e Date modified Type

=5 No items match your search.

fecant e Example: "TEX_print" for the folder to save to, and "

.Emp tex.ps " as the file name

=

Libraries

i~ ®@cClick [Save].
The CMYK layer of the image is saved as a PS file.

Computer
2
A

Network

O

—

@ Open the folder you saved to and make sure the file has been created.
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4-2 Performing Texture Printing

Performing Texture Printing

Procedure

0 Prepare the printing data having been created in the previous process which is de-
scribed in "Create The Texture Printing Data" on page 55.

9 Make the setting to output metallic silver ink with the VersaWorks, and execute the
printing.
To use metallic silver ink, you need to select "CMYKMLt", etc. in the print mode of the VersaWorks.
For the detailed method of setting, please refer to “Chapter 3 Printing”.

Printing a Texture Chart

The texture chart is the printing sample of the texture pattern. By printing the texture chart, you can confirm
the “complete texture chart” representing the texture itself that can be printed with “Your Printer” and “Your
Media” (slight pattern differences is possible to occur depending on the conditions of the printer and media.)
By selecting a pattern from this texture chart and creating the printing data using that selected pattern, you
can print your intended pattern almost perfectly.

procedure
o Roland VersaWorks DOUb|e-c|ick @.

File(F) Edit(E) View(V) JobU) Printer(®) Media(M) Help() The [Queue A Properties] window appears.

1 XC-540MT

Statuc :Ready to Print

, configure the settings in [Qual-
ity Settings] and [Color Management].

@ Guality S etting: .
— ’7 Media Type @Chck [OK]_
p - @ [ Generic vingl 1(MT] |
Print Quality: & High Quality
 High Quality [Layersd]

2)

anca\

Note: When printing a texture chart, the [Quality] settings from the [Queue Properties] window are always
applied. Since you cannot change the quality settings for the job using the [Job Settings] window after it
has been added, be sure to configure the settings in the [Queue Properties] window before performing the
following operations.
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4-2 Performing Texture Printi

(3]

ng

B Ro
File(F) Edit(E) View(V) Job()) Printer(P) | Media(M)| Help(H)

Status | Job Name:

Print Status @

Media Explorer(W)

Print Roland Color System Library

Color Chart Type-1

Color Chart Type-2

Color Selector

Color Chips »
Print Roland Metallic Color System Library

Metallic Color Chart

Metallic Color Selector

Metallic Color Chips »

[ RIP Status [
i

- wrary
Chart ]

The fallowing job will be printed.
Do you want to continue?

File Mamne : Chart
FPage Size: 4199296 9mm« 1P

Cusue & ' Queus B

\

B Chart

Press [F1] for Help
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Dclick [Chart] under [Print Roland Texture
System Library] form the [Media] menu.
This message appears: The following job will be
printed. Do you want to continue? Check that the
media in the printer is large enough for the displayed
page size.

®@Click [OK].
The texture chart is added to the job list.

Click @

Rip'ing and printing the texture chart are per-
formed.

* In the texture chart, color is added to part of the
background of the texture. This makes the design of
the texture clear.
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Chapter 5
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Message for Ink Circulation

When Dot Drop-out Etc. Cannot be Corrected............ccceeenne
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5-1 Maintenance

Message for Ink Circulation

With this machine, white ink and metallic silver ink are circulated periodically to prevent the ink precipitation.
When the following message appears, please wait until the display changes.
[CIRCULATING INK]

In order to allow the automatic maintenance such as above to be performed, please observe the items be-
low.

» Leave the main power on at all times.

» Never leave the front cover open for long periods.

» After finishing making the settings for the various menu items, go back to the top screen.

When Dot Drop-out Etc. Cannot be Corrected

When using metallic silver ink and white ink, incorrect ink discharge, such as generation of dot drop-out, may
occur even after cleaning is performed using the cleaning function or cleaning kit. This is due to the proper-
ties of metallic silver ink and white ink that ingredients tend to settle and separate, causing the precipitated
ingredients to solidify after the machine is left unattended for a long period. In such cases, perform the opera-
tion described below. This operation requires two cleaning cartridges.

| (IMPORTANT! )

Alarge amount of ink will be discharged during this operation. Perform this operation only when dot drop-out
and other issues cannot be corrected even after performing cleaning using the cleaning function (Normal,
Medium, Powerful) or cleaning kit. For how to perform cleaning using the cleaning function or cleaning kit,
refer to the XC-540/XC-540MT User's Manual.

Procedure

@ [venu «¢| Press Cvenu).
INK RENEWAL <] Press C_A D several times.

@ [ewpry Press .

DRAIN BOTTLE «| Discard the discharged fluid and attach the emptied bottle.

€ [REMOVE CARTRIDGE Press CENTER D |
12345678910 @D Remove the ink cartridges from slots 4 and 5.

‘ Number 4 (@ Insert SOL INK cleaning cartridges into slots 4 and 5.
and 5 flashes.

SET CARTRIDGE
12345678910

‘ Number 4
and 5 flashes.
RENEWING INK . . .
IOV

64 Chapter 5 Maintenance

Downloaded from www.Manualslib.com manuals search engine


http://www.manualslib.com/

5-1 Maintenance

@ [REMOVE CL-LIQUID Remove the SOL INK cleaning cartridges from slots 4 and 5.
12345678910 Carry out steps & and @ as many times as indicated by the
‘Number 4 on-screen messages.

and 5 flashes.

RENEWING INK . . .
IIIIIIIIIND

6 SET CARTRIDGE Insert the ink cartridges into slots 4 and 5.
12345678910

‘ Number 4 and

5 flashes.

RENEWING INK . . .
IIIIIIIIIIIIIIIIIYY

@ [w73semm |  Press Cuen>,
SETUP SHEET Press (< D to go back to the original screen.

{»ROLL
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